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Introduction

The primary defense of a submarine lies in its capacity to remain hidden during operation. 
As radio waves are strongly absorbed by sea water, sound navigation ranging, or SONAR, 
is one of the main methods used for the detection of submarines. Designers analyze the 
way acoustic waves are reflected in order to minimize the equivalent reflecting area of the 
submarine. The target strength, or TS, is a measure of the area of a sonar target. In most 
submarines, reduction of the backscatter signal is achieved through the application of 
absorbing materials to the outer surfaces of the submarine. 

This tutorial uses the BeTTSi benchmark submarine (Benchmark Target Echo Strength 
Simulation) presented in Ref. 1. This benchmark geometry, shown in Figure 1, presents 
features common in modern submarines without representing any actual submarine class.

Figure 1: BeTSSi submarine geometry.

This model is acoustically large and takes advantage of the stabilized formulation in the 
Pressure Acoustic, Boundary Elements interface (BEM). Enabling the stabilized 
formulation ensures convergence for large models (high frequency or large domains) at 
the cost of some additional degrees of freedom.
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Model Definition

The model uses the Background Pressure Field feature to represent a spherical wave emitted 
from a distance d_source of 1000 m at an angle phi of 330 ° from the bow of the 
submarine. By the time the waves reach the submarine, they behave locally as plane waves. 
The Ocean Attenuation material model is used to represent the losses existing in the 
transmitting media. This attenuation model is based on a semianalytical model with 
parameters that are based on extensive measurement data. It includes effects due to 
viscosity in pure water, the relaxation processes of boric acid and magnesium sulfate, as 
well as depth, temperature, salinity (practical), and pH value. 

The absorbing material placed on the hard surfaces is represented through the Absorption 

coefficient option in the Impedance boundary condition. The feature adds an impedance 
given by

 (1)

Where ρc is the complex density, i is the imaginary unit, ω is the angular frequency, Zi is 
the specific acoustic input impedance, cc is the complex speed of sound, R is the reflection 
coefficient, φ  is the phase, and αn is the normal incidence absorption coefficient. In this 
case, the impedance will be purely resistive, as φ  is set to 0.

The target strength, or TS, is computed following Equation 2:

 (2)

Where ps is the scattered pressure at the listening point, pin is the background pressure at 
the submarine and dlistening is the distance from the submarine to the listening point. As 
we will use d_source as the distance to the listening point, this equation has been 
modified in the variable definition.

Results and Discussion

Figure 2 shows the total acoustic pressure at the submarine surfaces. Note how the 
pressure waves are almost planar and how the side of the source “not illuminated” shows 
a significantly lower acoustic pressure. Note also the large number of wavelengths 
considered in the model, this is an acoustically large model.
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Figure 2: Total acoustic pressure at the submarine.

Figure 3 shows the radiation pattern at 100 m away from the submarine. The direction of 
propagation of the acoustic signal is marked with an arrow. Note the complex lobes that 
appear at this frequency and how the scattered signal will greatly depend on the actual 
position where it is measured.
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Figure 3: Radiation pattern 100 m away from the submarine.

A section cut of the scattered acoustic pressure through the center of the submarine is 
shown in Figure 4. 
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Figure 4: Section cut of the scattered acoustic pressure.

Another way to present this is to plot the scattered sound pressure level in the section, as 
shown in Figure 5.
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Figure 5: Section cut of the scattered sound pressure level.

Figure 6 shows the sound pressure level polar plot around the submarine, that is, the 
radiation pattern. Note the peaks right below the submarine and at the reflection angle 
from the source.
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Figure 6: Polar plot of the sound pressure level.

SONAR equipment can be run in passive and active configurations. In a passive SONAR, 
the sensor will just reflect the sound emitted by the submarine during its operation, while 
an active source will use some active method to generate an acoustic signal that will be 
reflected on the submarine. Active SONAR can be used in monostatic configurations, 
when the source and the listening point coincide, or in bistatic configurations, where the 
position of the source and the listening point are different. The target strength, as defined 
in Equation 2, for a bistatic configuration is shown in Figure 7. 
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Figure 7: Bistatic target strength of the submarine for a receiver situated at the same distance 
as the source.

Notes about the COMSOL implementation

The model uses an MPHBIN-file as the starting geometry. It is possible to generate this 
geometry. The instructions to do so are covered in the Geometry Sequence Instructions. 
Due to the complexity of the geometry and the use of Cap Face operations, the generation 
of the geometry requires the CAD Import Module and the Design Module.
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Application Library path: Acoustics_Module/Underwater_Acoustics/
submarine_target_strength

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click  Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click  3D.

2 In the Select Physics tree, select Acoustics>Pressure Acoustics>Pressure Acoustics,

 Boundary Elements (pabe).

3 Click Add.

4 Click  Study.

5 In the Select Study tree, select General Studies>Frequency Domain.

6 Click  Done.

The model uses an external file with the geometry sequence. The operations required to 
generate this geometry are specified at the end of the document.

G E O M E T R Y  1

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, locate the Advanced section.

3 From the Geometry representation list, choose CAD kernel.

4 In the Geometry toolbar, click  Insert Sequence.

5 Browse to the model’s Application Libraries folder and double-click the file 
submarine_target_strength_geom_sequence.mph.

6 In the Geometry toolbar, click  Build All.

The geometry should look like Figure 1.

7 In the Model Builder window, collapse the Geometry 1 node.
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The model with the geometry contained some parameters. Rename the parameter group 
to facilitate the navigation through the model.

G L O B A L  D E F I N I T I O N S

Geometry Parameters
1 In the Model Builder window, under Global Definitions click Parameters 1.

2 In the Settings window for Parameters, type Geometry Parameters in the Label text 
field.

Create a new parameter group and import the parameters from a file.

Model Parameters
1 In the Home toolbar, click  Parameters and choose Add>Parameters.

2 In the Settings window for Parameters, type Model Parameters in the Label text field.

3 Locate the Parameters section. Click  Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
submarine_target_strength_parameters.txt.

The average operator is used to obtain the average incoming pressure over the submarine.

D E F I N I T I O N S

Average 1 (aveop1)
1 In the Definitions toolbar, click  Nonlocal Couplings and choose Average.

2 In the Settings window for Average, locate the Source Selection section.

3 From the Geometric entity level list, choose Boundary.

4 From the Selection list, choose All boundaries.

Add new variables that will be used in the postprocessing.

Variables 1
1 In the Model Builder window, right-click Definitions and choose Variables.

2 In the Settings window for Variables, locate the Variables section.
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3 In the table, enter the following settings:

A D D  M A T E R I A L

1 In the Home toolbar, click  Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Built-in>Water, liquid.

4 Click Add to Component in the window toolbar.

5 In the Home toolbar, click  Add Material to close the Add Material window.

M A T E R I A L S

Water, liquid (mat1)
1 In the Settings window for Material, locate the Geometric Entity Selection section.

2 From the Selection list, choose All voids.

P R E S S U R E  A C O U S T I C S ,  B O U N D A R Y  E L E M E N T S  ( P A B E )

1 In the Model Builder window, under Component 1 (comp1) click Pressure Acoustics,

 Boundary Elements (pabe).

2 In the Settings window for Pressure Acoustics, Boundary Elements, locate the 
Domain Selection section.

3 From the Selection list, choose All voids.

4 Locate the Sound Pressure Level Settings section. From the 
Reference pressure for the sound pressure level list, choose 
Use reference pressure for water.

This model is very large compared to the wavelength. Use the stabilized formulation in 
the Pressure Acoustics, Boundary Elements physics. This will ensure the convergence of 
the iterative solver. Without stabilization, the iterative solver will not converge above 
about 800 Hz, and will require a very large number of iterations as the excitation 
approaches this frequency.

5 Click the  Show More Options button in the Model Builder toolbar.

6 In the Show More Options dialog box, select Physics>Stabilization in the tree.

Name Expression Unit Description

TS 20*log10((abs(pabe.p_s)/p_in)*
d_source/1[m])

Target 
strength

p_in aveop1(abs(pabe.p_b)) Pa Incoming 
pressure
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7 In the tree, select the check box for the node Physics>Stabilization.

8 Click OK.

9 In the Settings window for Pressure Acoustics, Boundary Elements, click to expand the 
Stabilization section.

10 Select the Stabilized formulation check box.

Turn on the ocean attenuation model which is specially relevant at high frequencies.

Pressure Acoustics 1
1 In the Model Builder window, under Component 1 (comp1)>Pressure Acoustics,

 Boundary Elements (pabe) click Pressure Acoustics 1.

2 In the Settings window for Pressure Acoustics, locate the Pressure Acoustics Model 
section.

3 From the Fluid model list, choose Ocean attenuation.

4 Locate the Model Input section. In the D text field, type depth.

Background Pressure Field 1
1 In the Physics toolbar, click  Domains and choose Background Pressure Field.

The background field is generated by a source at a distance given by the d_source 
parameter. By the time the spherical waves have reached the target, they locally behave 
as plane waves.

2 In the Settings window for Background Pressure Field, locate the 
Background Pressure Field section.

3 From the Pressure field type list, choose Spherical wave.

4 In the p0 text field, type p_ref.

5 Specify the x0 vector as

Impedance 1
1 In the Physics toolbar, click  Boundaries and choose Impedance.

The submarine uses some anechoic coating to reduce the scattered signal. This 
absorption coefficient could be specified as frequently dependent, but in this cases it 
takes the value of the alpha_n parameter.

2 In the Settings window for Impedance, locate the Boundary Selection section.

-d_source*cos(phi) x

-d_source*sin(phi) y

0 z
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3 From the Selection list, choose All boundaries.

4 Locate the Impedance section. From the Impedance model list, choose 
Absorption coefficient.

5 In the αn text field, type alpha_n.

M E S H  1

Mapped 1
1 In the Mesh toolbar, click  Boundary and choose Mapped.

To reduce the computation cost, it is advisable to use a mapped mesh when possible.

2 Select Boundaries 19–36, 41–44, 49–52, 55, 56, 59–61, 64–66, and 91–98 only.

Distribution 1
1 Right-click Mapped 1 and choose Distribution.

As the scattering characteristics are largely influenced by the sail, rudder and bow plane, 
create a finer mesh around the leading edge of these surfaces.

2 Select Edges 67, 70, 73–76, 102, and 103 only.

3 In the Settings window for Distribution, locate the Distribution section.

4 From the Distribution type list, choose Predefined.

5 In the Number of elements text field, type 20.

6 In the Element ratio text field, type 4.

7 Select the Reverse direction check box.

Distribution 2
1 In the Model Builder window, right-click Mapped 1 and choose Distribution.

2 Select Edges 105 and 107 only.

3 In the Settings window for Distribution, locate the Distribution section.

4 From the Distribution type list, choose Predefined.

5 In the Number of elements text field, type 65.

6 In the Element ratio text field, type 3.

Distribution 3
1 Right-click Mapped 1 and choose Distribution.

2 Select Edges 194, 195, 197, 198, 200, 201, 203–207, 209–211, 213, and 214 only.

3 In the Settings window for Distribution, locate the Distribution section.

4 From the Distribution type list, choose Predefined.
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5 In the Number of elements text field, type 20.

6 In the Element ratio text field, type 4.

Distribution 4
1 Right-click Mapped 1 and choose Distribution.

2 Select Edges 81 and 83 only.

3 In the Settings window for Distribution, locate the Distribution section.

4 In the Number of elements text field, type 2.

Size
1 In the Model Builder window, click Size.

2 In the Settings window for Size, locate the Element Size section.

3 Click the Custom button.

4 Locate the Element Size Parameters section. In the Maximum element size text field, type 
lam0/4.

5 In the Minimum element size text field, type 50[mm].

Free Triangular 1
1 In the Mesh toolbar, click  Boundary and choose Free Triangular.

2 In the Settings window for Free Triangular, locate the Boundary Selection section.

3 From the Geometric entity level list, choose Remaining.

4 Click to expand the Tessellation section. From the Method list, choose Advancing front.
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5 Click  Build All.

The mesh should look like this.

S T U D Y  1

Step 1: Frequency Domain
1 In the Model Builder window, under Study 1 click Step 1: Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Study Settings section.

3 In the Frequencies text field, type f_max.

The plots will be generated manually.

4 In the Model Builder window, click Study 1.

5 In the Settings window for Study, locate the Study Settings section.

6 Clear the Generate default plots check box.

The analysis should take approximately 25 minutes and require 45 GB of RAM. If the 
computer does not have enough RAM, the running time will be longer as COMSOL 
will rely on virtual memory.

7 In the Home toolbar, click  Compute.
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R E S U L T S

1 In the Model Builder window, click Results.

2 In the Settings window for Results, locate the Update of Results section.

3 Select the Only plot when requested check box.

4 Select the Recompute all plot data after solving check box.

5 Locate the Save Data in the Model section. From the Save plot data list, choose On.

Grid 3D 1
1 In the Model Builder window, expand the Results node.

2 Right-click Results>Datasets and choose More 3D Datasets>Grid 3D.

This grid will be used to evaluate the solution in the infinite domain surrounding the 
submarine.

3 In the Settings window for Grid 3D, locate the Parameter Bounds section.

4 Find the First parameter subsection. In the Minimum text field, type -20.

5 In the Maximum text field, type 80.

6 Find the Second parameter subsection. In the Minimum text field, type -25.

7 In the Maximum text field, type 25.

8 Find the Third parameter subsection. In the Minimum text field, type -0.1.

9 In the Maximum text field, type 0.1.

10 Click to expand the Resolution section. In the x resolution text field, type 500.

11 In the y resolution text field, type 250.

12 In the z resolution text field, type 3.

Cut Plane 1
1 In the Results toolbar, click  Cut Plane.

2 In the Settings window for Cut Plane, locate the Plane Data section.

3 From the Plane list, choose XY-planes.

Cut Plane 2
1 In the Results toolbar, click  Cut Plane.

2 In the Settings window for Cut Plane, locate the Data section.

3 From the Dataset list, choose Grid 3D 1.

4 Locate the Plane Data section. From the Plane list, choose xy-planes.
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Parameterized Curve 3D 1
1 In the Results toolbar, click  More Datasets and choose Parameterized Curve 3D.

This parametric curve is a circle around the submarine at a distance taken from the 
d_source parameter.

2 In the Settings window for Parameterized Curve 3D, locate the Parameter section.

3 In the Maximum text field, type 2*pi.

4 Locate the Expressions section. In the x text field, type -d_source*cos(s).

5 In the y text field, type -d_source*sin(s).

6 Select the Only evaluate globally defined expressions check box.

7 Click to expand the Resolution section. In the Resolution text field, type 10000.

8 Clear the Adaptive check box.

9 Click  Plot.

10 Click the  Zoom Extents button in the Graphics toolbar.

Total Pressure, Boundaries
1 In the Results toolbar, click  3D Plot Group.

2 In the Settings window for 3D Plot Group, type Total Pressure, Boundaries in the 
Label text field.

Surface 1
1 Right-click Total Pressure, Boundaries and choose Surface.

2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type pabe.p_t_bnd.

4 Locate the Coloring and Style section. From the Color table list, choose Wave.

5 Select the Symmetrize color range check box.

6 Click to expand the Quality section. From the Resolution list, choose Extra fine.

7 Click the  Show Grid button in the Graphics toolbar.

8 In the Total Pressure, Boundaries toolbar, click  Plot.

9 Click the  Zoom Extents button in the Graphics toolbar.

The plot should look like Figure 2.

Radiation Pattern at 100 m
1 In the Model Builder window, right-click Total Pressure, Boundaries and choose Duplicate.

2 In the Model Builder window, click Total Pressure, Boundaries 1.
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3 In the Settings window for 3D Plot Group, type Radiation Pattern at 100 m in the 
Label text field.

4 Locate the Plot Settings section. From the View list, choose New view.

5 Click to expand the Title section. From the Title type list, choose Label.

Surface 1
1 In the Model Builder window, click Surface 1.

2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type 0.

4 Click the  Show Grid button in the Graphics toolbar.

5 Click to expand the Title section. From the Title type list, choose None.

Material Appearance 1
1 Right-click Surface 1 and choose Material Appearance.

2 In the Settings window for Material Appearance, locate the Appearance section.

3 From the Appearance list, choose Custom.

4 From the Material type list, choose Carbon (forged).

5 In the Radiation Pattern at 100 m toolbar, click  Plot.

Radiation Pattern at 100 m
In the Model Builder window, click Radiation Pattern at 100 m.

Radiation Pattern 1
1 In the Radiation Pattern at 100 m toolbar, click  More Plots and choose 

Radiation Pattern.

2 In the Settings window for Radiation Pattern, locate the Expression section.

3 In the Expression text field, type 100[m]+pabe.Lp_s[m].

4 Select the Description check box.

5 In the associated text field, type Scattered sound pressure level at 100[m].

6 Clear the Use as color expression check box.

7 Locate the Color section. In the Expression text field, type pabe.Lp_s.

8 Click to expand the Range section. Select the Manual color range check box.

9 In the Minimum text field, type 0.

10 In the Maximum text field, type 55.

11 Locate the Evaluation section. Find the Angles subsection. In the 
Number of elevation angles text field, type 120.
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12 In the Number of azimuth angles text field, type 1440.

13 From the Restriction list, choose Manual.

14 In the θ start text field, type 75.

15 In the θ range text field, type 30.

16 Find the Sphere subsection. From the Sphere list, choose Manual.

17 In the X text field, type a+L/2.

18 In the Radius text field, type 100[m].

19 In the Radiation Pattern at 100 m toolbar, click  Plot.

Arrow Surface 1
1 Right-click Radiation Pattern at 100 m and choose Arrow Surface.

2 In the Settings window for Arrow Surface, locate the Expression section.

3 In the X component text field, type cos(phi).

4 In the Y component text field, type sin(phi).

5 In the Z component text field, type 0.

6 Click to expand the Title section. From the Title type list, choose None.

7 Locate the Arrow Positioning section. From the Placement list, choose 
Uniform anisotropic.

8 In the Number of arrows text field, type 1.

9 In the X weight text field, type 0.1.

10 Locate the Coloring and Style section. From the Arrow base list, choose Head.

11 Select the Scale factor check box.

12 In the associated text field, type 50.

Selection 1
1 Right-click Arrow Surface 1 and choose Selection.

2 Select Boundary 36 only.

3 In the Radiation Pattern at 100 m toolbar, click  Plot.

4 Click the  Zoom Extents button in the Graphics toolbar.

The plot should look like Figure 3.

Scattered Pressure at z=0
1 In the Home toolbar, click  Add Plot Group and choose 2D Plot Group.
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2 In the Settings window for 2D Plot Group, type Scattered Pressure at z=0 in the 
Label text field.

Surface 1
1 Right-click Scattered Pressure at z=0 and choose Surface.

2 In the Settings window for Surface, locate the Data section.

3 From the Dataset list, choose Cut Plane 2.

4 Locate the Expression section. In the Expression text field, type pabe.p_s.

5 Locate the Coloring and Style section. From the Color table list, choose Wave.

6 Select the Symmetrize color range check box.

7 In the Scattered Pressure at z=0 toolbar, click  Plot.

8 Click the  Zoom Extents button in the Graphics toolbar.

The plot should look like Figure 4.

Scattered Sound Pressure Level at z=0
1 In the Model Builder window, right-click Scattered Pressure at z=0 and choose Duplicate.

2 In the Model Builder window, click Scattered Pressure at z=0.1.

3 In the Settings window for 2D Plot Group, type Scattered Sound Pressure Level at 
z=0 in the Label text field.

Surface 1
1 In the Model Builder window, click Surface 1.

2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type pabe.Lp_s.

4 Locate the Coloring and Style section. From the Color table list, choose Rainbow.

5 Clear the Symmetrize color range check box.

6 In the Scattered Sound Pressure Level at z=0 toolbar, click  Plot.

The plot should look like Figure 5.

Radiation Pattern - Scattered Sound Pressure Level
1 In the Home toolbar, click  Add Plot Group and choose Polar Plot Group.

2 In the Settings window for Polar Plot Group, type Radiation Pattern - Scattered 
Sound Pressure Level in the Label text field.

3 Locate the Axis section. From the Zero angle list, choose Left.
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Radiation Pattern 1
1 In the Radiation Pattern - Scattered Sound Pressure Level toolbar, click  More Plots 

and choose Radiation Pattern.

2 In the Settings window for Radiation Pattern, locate the Expression section.

3 In the Expression text field, type pabe.Lp_s.

4 Locate the Evaluation section. Find the Angles subsection. In the Number of angles text 
field, type 5000.

5 Find the Evaluation distance subsection. In the Radius text field, type d_source.

6 Find the Reference direction subsection. In the x text field, type -1.

7 Click Preview Evaluation Plane.

8 Click the  Zoom Extents button in the Graphics toolbar.

The plot should look like this.

9 In the Radiation Pattern - Scattered Sound Pressure Level toolbar, click  Plot.

The plot should look like Figure 6.

Bistatic Target Strength
1 In the Home toolbar, click  Add Plot Group and choose 1D Plot Group.
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2 In the Settings window for 1D Plot Group, type Bistatic Target Strength in the 
Label text field.

3 Locate the Data section. From the Dataset list, choose Parameterized Curve 3D 1.

Line Graph 1
1 Right-click Bistatic Target Strength and choose Line Graph.

2 In the Settings window for Line Graph, locate the y-Axis Data section.

3 In the Expression text field, type TS.

4 Locate the x-Axis Data section. From the Parameter list, choose Expression.

5 In the Expression text field, type s[rad].

6 From the Unit list, choose °.

7 Select the Description check box.

8 In the associated text field, type Receiver angle.

9 In the Bistatic Target Strength toolbar, click  Plot.

The plot should look like Figure 7.

Geometry Sequence Instructions

From the File menu, choose New.

N E W

In the New window, click  Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click  3D.

2 Click  Done.

G E O M E T R Y  1

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, locate the Advanced section.

3 From the Geometry representation list, choose CAD kernel.

G L O B A L  D E F I N I T I O N S

Geometry Parameters
1 In the Model Builder window, under Global Definitions click Parameters 1.

2 In the Settings window for Parameters, locate the Parameters section.
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3 Click  Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
submarine_target_strength_geom_sequence_parameters.txt.

5 In the Label text field, type Geometry Parameters.

G E O M E T R Y  1

Work Plane 1 (wp1)
In the Geometry toolbar, click  Work Plane.

Work Plane 1 (wp1)>Plane Geometry
In the Model Builder window, click Plane Geometry.

Work Plane 1 (wp1)>Ellipse 1 (e1)
1 In the Work Plane toolbar, click  Ellipse.

2 In the Settings window for Ellipse, locate the Object Type section.

3 From the Type list, choose Curve.

4 Locate the Size and Shape section. In the a-semiaxis text field, type b.

5 In the b-semiaxis text field, type a.

6 In the Sector angle text field, type 90.

7 Locate the Position section. In the xw text field, type a.

8 Locate the Rotation Angle section. In the Rotation text field, type 90.

9 Click  Build Selected.

Work Plane 1 (wp1)>Line Segment 1 (ls1)
1 In the Work Plane toolbar, click  More Primitives and choose Line Segment.

2 On the object e1, select Point 1 only.

3 In the Settings window for Line Segment, locate the Endpoint section.

4 From the Specify list, choose Coordinates.

5 In the xw text field, type a+L.

6 In the yw text field, type b.

7 Click  Build Selected.

8 Click the  Zoom Extents button in the Graphics toolbar.

Work Plane 1 (wp1)>Circle 1 (c1)
1 In the Work Plane toolbar, click  Circle.

2 In the Settings window for Circle, locate the Object Type section.
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3 From the Type list, choose Curve.

4 Locate the Size and Shape section. In the Radius text field, type g2/sin(alpha).

5 In the Sector angle text field, type alpha.

6 Locate the Position section. In the xw text field, type a+L.

7 In the yw text field, type b-g2/sin(alpha).

8 Locate the Rotation Angle section. In the Rotation text field, type 90-alpha.

9 Click  Build Selected.

Work Plane 1 (wp1)>Line Segment 2 (ls2)
1 In the Work Plane toolbar, click  More Primitives and choose Line Segment.

2 On the object c1, select Point 1 only.

3 In the Settings window for Line Segment, locate the Endpoint section.

4 From the Specify list, choose Coordinates.

5 In the xw text field, type a+L+g2+g3.

6 In the yw text field, type (b-(1-cos(alpha))*g2/sin(alpha))-g3*tan(alpha).

7 Click  Build Selected.

8 Click the  Zoom Extents button in the Graphics toolbar.

Work Plane 1 (wp1)>Delete Entities 1 (del1)
1 Right-click Plane Geometry and choose Delete Entities.

2 On the object c1, select Boundaries 2 and 3 only.

3 On the object e1, select Boundaries 2 and 3 only.

4 In the Work Plane toolbar, click  Build All.

Revolve 1 (rev1)
1 In the Model Builder window, under Component 1 (comp1)>Geometry 1 right-click 

Work Plane 1 (wp1) and choose Revolve.

2 In the Settings window for Revolve, locate the Revolution Angles section.

3 Click the Angles button.

4 In the Start angle text field, type 60[deg].

5 In the End angle text field, type 180[deg].

6 Locate the Revolution Axis section. Find the Direction of revolution axis subsection. In 
the xw text field, type 1.

7 In the yw text field, type 0.
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8 Click  Build Selected.

Work Plane 2 (wp2)
1 In the Geometry toolbar, click  Work Plane.

2 In the Settings window for Work Plane, locate the Plane Definition section.

3 From the Plane list, choose zy-plane.

4 In the x-coordinate text field, type a.

5 Click  Build Selected.

Work Plane 2 (wp2)>Plane Geometry
In the Model Builder window, click Plane Geometry.

Work Plane 2 (wp2)>Polygon 1 (pol1)
1 In the Work Plane toolbar, click  Polygon.

2 In the Settings window for Polygon, locate the Object Type section.

3 From the Type list, choose Open curve.

4 Locate the Coordinates section. In the table, enter the following settings:

5 Click  Build Selected.

6 Click the  Zoom Extents button in the Graphics toolbar.

Extrude 1 (ext1)
1 In the Model Builder window, under Component 1 (comp1)>Geometry 1 right-click 

Work Plane 2 (wp2) and choose Extrude.

xw (m) yw (m)

0 c_deck

s_deck c_deck

-(-sin(theta)*b+
s_deck)/6+s_deck

c_deck-(p_a*((-sin(theta)*b+s_deck)/6)^3+p_b*
((-sin(theta)*b+s_deck)/6)^2)

-(-sin(theta)*b+
s_deck)*2/6+s_deck

c_deck-(p_a*((-sin(theta)*b+s_deck)*2/6)^3+
p_b*((-sin(theta)*b+s_deck)*2/6)^2)

-(-sin(theta)*b+
1.2[m])*3/6+s_deck

c_deck-(p_a*((-sin(theta)*b+s_deck)*3/6)^3+
p_b*((-sin(theta)*b+s_deck)*3/6)^2)

-(-sin(theta)*b+
1.2[m])*4/6+s_deck

c_deck-(p_a*((-sin(theta)*b+s_deck)*4/6)^3+
p_b*((-sin(theta)*b+s_deck)*4/6)^2)

-(-sin(theta)*b+
1.2[m])*5/6+s_deck

c_deck-(p_a*((-sin(theta)*b+s_deck)*5/6)^3+
p_b*((-sin(theta)*b+s_deck)*5/6)^2)

-(-sin(theta)*b+
1.2[m])*6/6+s_deck

c_deck-(p_a*((-sin(theta)*b+s_deck)*6/6)^3+
p_b*((-sin(theta)*b+s_deck)*6/6)^2)
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2 In the Settings window for Extrude, locate the Distances section.

3 In the table, enter the following settings:

4 Select the Reverse direction check box.

5 Click  Build Selected.

Work Plane 3 (wp3)
1 In the Geometry toolbar, click  Work Plane.

2 In the Settings window for Work Plane, locate the Plane Definition section.

3 From the Plane type list, choose Coordinates.

4 In row Point 3, set y to cos(theta).

5 In row Point 3, set z to sin(theta).

Work Plane 3 (wp3)>Plane Geometry
In the Model Builder window, click Plane Geometry.

Work Plane 3 (wp3)>Line Segment 1 (ls1)
1 In the Work Plane toolbar, click  More Primitives and choose Line Segment.

2 In the Settings window for Line Segment, locate the Starting Point section.

3 From the Specify list, choose Coordinates.

4 In the xw text field, type a+L+g2.

5 In the yw text field, type (b-(1-cos(alpha))*g2/sin(alpha)).

6 Locate the Endpoint section. From the Specify list, choose Coordinates.

7 In the xw text field, type a+L+g2+g3.

8 In the yw text field, type (b-(1-cos(alpha))*g2/sin(alpha))-g3*tan(alpha).

9 Click  Build Selected.

Revolve 2 (rev2)
1 In the Model Builder window, under Component 1 (comp1)>Geometry 1 right-click 

Work Plane 3 (wp3) and choose Revolve.

2 In the Settings window for Revolve, locate the Revolution Angles section.

3 Click the Angles button.

4 In the End angle text field, type -60.

Distances (m)

L
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5 Locate the Revolution Axis section. Find the Direction of revolution axis subsection. In 
the xw text field, type 1.

6 In the yw text field, type 0.

7 Click  Build Selected.

Work Plane 4 (wp4)
1 In the Geometry toolbar, click  Work Plane.

2 In the Settings window for Work Plane, locate the Plane Definition section.

3 From the Plane type list, choose Coordinates.

4 In row Point 3, set x to 7.

5 In row Point 3, set y to c_deck.

6 In row Point 3, set z to s_deck.

7 Click  Build Selected.

Work Plane 4 (wp4)>Plane Geometry
In the Model Builder window, click Plane Geometry.

Work Plane 4 (wp4)>Ellipse 1 (e1)
1 In the Work Plane toolbar, click  Ellipse.

2 In the Settings window for Ellipse, locate the Object Type section.

3 From the Type list, choose Curve.

4 Locate the Size and Shape section. In the a-semiaxis text field, type a.

5 In the b-semiaxis text field, type sqrt(c_deck^2+s_deck^2).

6 In the Sector angle text field, type 180.

7 Locate the Position section. In the xw text field, type a.

8 Click  Build Selected.

Work Plane 4 (wp4)>Interpolation Curve 1 (ic1)
1 In the Work Plane toolbar, click  More Primitives and choose Interpolation Curve.

2 In the Settings window for Interpolation Curve, locate the Interpolation Points section.

3 In the table, enter the following settings:

xw (m) yw (m)

a+L-0.1[m] sqrt(c_deck^2+s_deck^2)

a+L sqrt(c_deck^2+s_deck^2)
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4 Click  Build Selected.

Work Plane 4 (wp4)>Line Segment 1 (ls1)
1 In the Work Plane toolbar, click  More Primitives and choose Line Segment.

2 In the Settings window for Line Segment, locate the Starting Point section.

3 From the Specify list, choose Coordinates.

4 In the xw text field, type a+L.

5 Locate the Endpoint section. From the Specify list, choose Coordinates.

6 In the xw text field, type a+L.

7 In the yw text field, type c_deck+s_deck.

8 Click  Build Selected.

Work Plane 4 (wp4)>Line Segment 2 (ls2)
1 In the Work Plane toolbar, click  More Primitives and choose Line Segment.

2 In the Settings window for Line Segment, locate the Starting Point section.

3 From the Specify list, choose Coordinates.

4 In the xw text field, type a+L+g2.

5 Locate the Endpoint section. From the Specify list, choose Coordinates.

6 In the xw text field, type a+L+g2.

7 In the yw text field, type c_deck+s_deck.

8 Click  Build Selected.

Work Plane 4 (wp4)>Union 1 (uni1)
1 In the Work Plane toolbar, click  Booleans and Partitions and choose Union.

2 Select the object  only.

3 Click the  Select All button in the Graphics toolbar.

4 In the Settings window for Union, click  Build Selected.

Work Plane 4 (wp4)>Delete Entities 1 (del1)
1 Right-click Plane Geometry and choose Delete Entities.

2 On the object uni1, select Boundaries 1–6, 8, 9, and 11 only.

3 In the Settings window for Delete Entities, click  Build Selected.

a+L+g2 (b-(1-cos(alpha))*g2/sin(alpha))

a+L+g2+0.1[m] (b-(1-cos(alpha))*g2/sin(alpha))-0.1[m]*tan(alpha)

xw (m) yw (m)
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Work Plane 4 (wp4)
1 In the Model Builder window, click Work Plane 4 (wp4).

2 In the Settings window for Work Plane, click  Build Selected.

Work Plane 5 (wp5)
1 In the Geometry toolbar, click  Work Plane.

2 In the Settings window for Work Plane, locate the Plane Definition section.

3 From the Plane type list, choose Coordinates.

4 In row Point 3, set x to 7.

5 In row Point 3, set y to c_deck-(p_a*((-sin(theta)*b+s_deck)/6)^3+p_b*((-
sin(theta)*b+s_deck)/6)^2).

6 In row Point 3, set z to -(-sin(theta)*b+s_deck)/6+s_deck.

7 Click  Build Selected.

Work Plane 5 (wp5)>Plane Geometry
In the Model Builder window, click Plane Geometry.

Work Plane 5 (wp5)>Ellipse 1 (e1)
1 In the Work Plane toolbar, click  Ellipse.

2 In the Settings window for Ellipse, locate the Object Type section.

3 From the Type list, choose Curve.

4 Locate the Size and Shape section. In the a-semiaxis text field, type a.

5 In the b-semiaxis text field, type sqrt((c_deck-(p_a*((-sin(theta)*b+s_deck)/
6)^3+p_b*((-sin(theta)*b+s_deck)/6)^2))^2+(-(-sin(theta)*b+s_deck)/

6+s_deck)^2).

6 In the Sector angle text field, type 180.

7 Locate the Position section. In the xw text field, type a.

8 Click  Build Selected.

Work Plane 5 (wp5)>Interpolation Curve 1 (ic1)
1 In the Work Plane toolbar, click  More Primitives and choose Interpolation Curve.

2 In the Settings window for Interpolation Curve, locate the Interpolation Points section.
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3 In the table, enter the following settings:

4 Click  Build Selected.

Work Plane 5 (wp5)>Line Segment 1 (ls1)
1 In the Work Plane toolbar, click  More Primitives and choose Line Segment.

2 In the Settings window for Line Segment, locate the Starting Point section.

3 From the Specify list, choose Coordinates.

4 In the xw text field, type a+L.

5 Locate the Endpoint section. From the Specify list, choose Coordinates.

6 In the xw text field, type a+L.

7 In the yw text field, type c_deck+s_deck.

8 Click  Build Selected.

Work Plane 5 (wp5)>Line Segment 2 (ls2)
1 In the Work Plane toolbar, click  More Primitives and choose Line Segment.

2 In the Settings window for Line Segment, locate the Starting Point section.

3 From the Specify list, choose Coordinates.

4 In the xw text field, type a+L+g2.

5 Locate the Endpoint section. From the Specify list, choose Coordinates.

6 In the xw text field, type a+L+g2.

7 In the yw text field, type c_deck+s_deck.

8 Click  Build Selected.

xw (m) yw (m)

a+L-
0.1[m
]

sqrt((c_deck-(p_a*((-sin(theta)*b+s_deck)/6)^3+p_b*((-
sin(theta)*b+s_deck)/6)^2))^2+(-(-sin(theta)*b+s_deck)/6+
s_deck)^2)

a+L sqrt((c_deck-(p_a*((-sin(theta)*b+s_deck)/6)^3+p_b*((-
sin(theta)*b+s_deck)/6)^2))^2+(-(-sin(theta)*b+s_deck)/6+
s_deck)^2)

a+L+
g2

(b-(1-cos(alpha))*g2/sin(alpha))

a+L+
g2+
0.1[m
]

(b-(1-cos(alpha))*g2/sin(alpha))-0.1[m]*tan(alpha)
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Work Plane 5 (wp5)>Union 1 (uni1)
1 In the Work Plane toolbar, click  Booleans and Partitions and choose Union.

2 Select the object  only.

3 Click the  Select All button in the Graphics toolbar.

4 In the Settings window for Union, click  Build Selected.

Work Plane 5 (wp5)>Delete Entities 1 (del1)
1 Right-click Plane Geometry and choose Delete Entities.

2 On the object uni1, select Boundaries 1–6, 8, 9, and 11 only.

3 In the Settings window for Delete Entities, click  Build Selected.

Work Plane 5 (wp5)
1 In the Model Builder window, click Work Plane 5 (wp5).

2 In the Settings window for Work Plane, click  Build Selected.

Work Plane 6 (wp6)
1 In the Geometry toolbar, click  Work Plane.

2 In the Settings window for Work Plane, locate the Plane Definition section.

3 From the Plane type list, choose Coordinates.

4 In row Point 3, set x to 7.

5 In row Point 3, set y to c_deck-(p_a*((-sin(theta)*b+s_deck)*2/6)^3+p_b*((-
sin(theta)*b+s_deck)*2/6)^2).

6 In row Point 3, set z to -(-sin(theta)*b+s_deck)*2/6+s_deck.

7 Click  Build Selected.

Work Plane 6 (wp6)>Plane Geometry
In the Model Builder window, click Plane Geometry.

Work Plane 6 (wp6)>Ellipse 1 (e1)
1 In the Work Plane toolbar, click  Ellipse.

2 In the Settings window for Ellipse, locate the Object Type section.

3 From the Type list, choose Curve.

4 Locate the Size and Shape section. In the a-semiaxis text field, type a.

5 In the b-semiaxis text field, type sqrt((c_deck-(p_a*((-sin(theta)*b+s_deck)*
2/6)^3+p_b*((-sin(theta)*b+s_deck)*2/6)^2))^2+(-(-sin(theta)*b+

s_deck)*2/6+s_deck)^2).

6 In the Sector angle text field, type 180.
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7 Locate the Position section. In the xw text field, type a.

8 Click  Build Selected.

Work Plane 6 (wp6)>Interpolation Curve 1 (ic1)
1 In the Work Plane toolbar, click  More Primitives and choose Interpolation Curve.

2 In the Settings window for Interpolation Curve, locate the Interpolation Points section.

3 In the table, enter the following settings:

4 Click  Build Selected.

Work Plane 6 (wp6)>Line Segment 1 (ls1)
1 In the Work Plane toolbar, click  More Primitives and choose Line Segment.

2 In the Settings window for Line Segment, locate the Starting Point section.

3 From the Specify list, choose Coordinates.

4 In the xw text field, type a+L.

5 Locate the Endpoint section. From the Specify list, choose Coordinates.

6 In the xw text field, type a+L.

7 In the yw text field, type c_deck+s_deck.

8 Click  Build Selected.

Work Plane 6 (wp6)>Line Segment 2 (ls2)
1 In the Work Plane toolbar, click  More Primitives and choose Line Segment.

2 In the Settings window for Line Segment, locate the Starting Point section.

3 From the Specify list, choose Coordinates.

4 In the xw text field, type a+L+g2.

xw (m) yw (m)

a+L-
0.1[m
]

sqrt((c_deck-(p_a*((-sin(theta)*b+s_deck)*2/6)^3+p_b*((-
sin(theta)*b+s_deck)*2/6)^2))^2+(-(-sin(theta)*b+s_deck)*2/6+
s_deck)^2)

a+L sqrt((c_deck-(p_a*((-sin(theta)*b+s_deck)*2/6)^3+p_b*((-
sin(theta)*b+s_deck)*2/6)^2))^2+(-(-sin(theta)*b+s_deck)*2/6+
s_deck)^2)

a+L+
g2

(b-(1-cos(alpha))*g2/sin(alpha))

a+L+
g2+
0.1[m
]

(b-(1-cos(alpha))*g2/sin(alpha))-0.1[m]*tan(alpha)
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5 Locate the Endpoint section. From the Specify list, choose Coordinates.

6 In the xw text field, type a+L+g2.

7 In the yw text field, type c_deck+s_deck.

8 Click  Build Selected.

Work Plane 6 (wp6)>Union 1 (uni1)
1 In the Work Plane toolbar, click  Booleans and Partitions and choose Union.

2 Select the object  only.

3 Click the  Select All button in the Graphics toolbar.

4 In the Settings window for Union, click  Build Selected.

Work Plane 6 (wp6)>Delete Entities 1 (del1)
1 Right-click Plane Geometry and choose Delete Entities.

2 On the object uni1, select Boundaries 1–6, 8, 9, and 11 only.

3 In the Settings window for Delete Entities, click  Build Selected.

Work Plane 6 (wp6)
1 In the Model Builder window, click Work Plane 6 (wp6).

2 In the Settings window for Work Plane, click  Build Selected.

Work Plane 7 (wp7)
1 In the Geometry toolbar, click  Work Plane.

2 In the Settings window for Work Plane, locate the Plane Definition section.

3 From the Plane type list, choose Coordinates.

4 In row Point 3, set x to 7.

5 In row Point 3, set y to c_deck-(p_a*((-sin(theta)*b+s_deck)*3/6)^3+p_b*((-
sin(theta)*b+s_deck)*3/6)^2).

6 In row Point 3, set z to -(-sin(theta)*b+s_deck)*3/6+s_deck.

7 Click  Build Selected.

Work Plane 7 (wp7)>Plane Geometry
In the Model Builder window, click Plane Geometry.

Work Plane 7 (wp7)>Ellipse 1 (e1)
1 In the Work Plane toolbar, click  Ellipse.

2 In the Settings window for Ellipse, locate the Object Type section.

3 From the Type list, choose Curve.
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4 Locate the Size and Shape section. In the a-semiaxis text field, type a.

5 In the b-semiaxis text field, type sqrt((c_deck-(p_a*((-sin(theta)*b+s_deck)*
3/6)^3+p_b*((-sin(theta)*b+s_deck)*3/6)^2))^2+(-(-sin(theta)*b+

s_deck)*3/6+s_deck)^2).

6 In the Sector angle text field, type 180.

7 Locate the Position section. In the xw text field, type a.

8 Click  Build Selected.

Work Plane 7 (wp7)>Interpolation Curve 1 (ic1)
1 In the Work Plane toolbar, click  More Primitives and choose Interpolation Curve.

2 In the Settings window for Interpolation Curve, locate the Interpolation Points section.

3 In the table, enter the following settings:

4 Click  Build Selected.

Work Plane 7 (wp7)>Line Segment 1 (ls1)
1 In the Work Plane toolbar, click  More Primitives and choose Line Segment.

2 In the Settings window for Line Segment, locate the Starting Point section.

3 From the Specify list, choose Coordinates.

4 In the xw text field, type a+L.

5 Locate the Endpoint section. From the Specify list, choose Coordinates.

6 In the xw text field, type a+L.

7 In the yw text field, type c_deck+s_deck.

8 Click  Build Selected.

xw (m) yw (m)

a+L-
0.1[m
]

sqrt((c_deck-(p_a*((-sin(theta)*b+s_deck)*3/6)^3+p_b*((-
sin(theta)*b+s_deck)*3/6)^2))^2+(-(-sin(theta)*b+s_deck)*3/6+
s_deck)^2)

a+L sqrt((c_deck-(p_a*((-sin(theta)*b+s_deck)*3/6)^3+p_b*((-
sin(theta)*b+s_deck)*3/6)^2))^2+(-(-sin(theta)*b+s_deck)*3/6+
s_deck)^2)

a+L+
g2

(b-(1-cos(alpha))*g2/sin(alpha))

a+L+
g2+
0.1[m
]

(b-(1-cos(alpha))*g2/sin(alpha))-0.1[m]*tan(alpha)
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Work Plane 7 (wp7)>Line Segment 2 (ls2)
1 In the Work Plane toolbar, click  More Primitives and choose Line Segment.

2 In the Settings window for Line Segment, locate the Starting Point section.

3 From the Specify list, choose Coordinates.

4 In the xw text field, type a+L+g2.

5 Locate the Endpoint section. From the Specify list, choose Coordinates.

6 In the xw text field, type a+L+g2.

7 In the yw text field, type c_deck+s_deck.

8 Click  Build Selected.

Work Plane 7 (wp7)>Union 1 (uni1)
1 In the Work Plane toolbar, click  Booleans and Partitions and choose Union.

2 Select the object  only.

3 Click the  Select All button in the Graphics toolbar.

4 In the Settings window for Union, click  Build Selected.

Work Plane 7 (wp7)>Delete Entities 1 (del1)
1 Right-click Plane Geometry and choose Delete Entities.

2 On the object uni1, select Boundaries 1–6, 8, 9, and 11 only.

3 In the Settings window for Delete Entities, click  Build Selected.

Work Plane 7 (wp7)
1 In the Model Builder window, click Work Plane 7 (wp7).

2 In the Settings window for Work Plane, click  Build Selected.

Work Plane 8 (wp8)
1 In the Geometry toolbar, click  Work Plane.

2 In the Settings window for Work Plane, locate the Plane Definition section.

3 From the Plane type list, choose Coordinates.

4 In row Point 3, set x to 7.

5 In row Point 3, set y to c_deck-(p_a*((-sin(theta)*b+s_deck)*4/6)^3+p_b*((-
sin(theta)*b+s_deck)*4/6)^2).

6 In row Point 3, set z to -(-sin(theta)*b+s_deck)*4/6+s_deck.

7 Click  Build Selected.
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Work Plane 8 (wp8)>Plane Geometry
In the Model Builder window, click Plane Geometry.

Work Plane 8 (wp8)>Ellipse 1 (e1)
1 In the Work Plane toolbar, click  Ellipse.

2 In the Settings window for Ellipse, locate the Object Type section.

3 From the Type list, choose Curve.

4 Locate the Size and Shape section. In the a-semiaxis text field, type a.

5 In the b-semiaxis text field, type sqrt((c_deck-(p_a*((-sin(theta)*b+s_deck)*
4/6)^3+p_b*((-sin(theta)*b+s_deck)*4/6)^2))^2+(-(-sin(theta)*b+

s_deck)*4/6+s_deck)^2).

6 In the Sector angle text field, type 180.

7 Locate the Position section. In the xw text field, type a.

8 Click  Build Selected.

Work Plane 8 (wp8)>Interpolation Curve 1 (ic1)
1 In the Work Plane toolbar, click  More Primitives and choose Interpolation Curve.

2 In the Settings window for Interpolation Curve, locate the Interpolation Points section.

3 In the table, enter the following settings:

4 Click  Build Selected.

Work Plane 8 (wp8)>Line Segment 1 (ls1)
1 In the Work Plane toolbar, click  More Primitives and choose Line Segment.

2 In the Settings window for Line Segment, locate the Starting Point section.

xw (m) yw (m)

a+L-
0.1[m
]

sqrt((c_deck-(p_a*((-sin(theta)*b+s_deck)*4/6)^3+p_b*((-
sin(theta)*b+s_deck)*4/6)^2))^2+(-(-sin(theta)*b+s_deck)*4/6+
s_deck)^2)

a+L sqrt((c_deck-(p_a*((-sin(theta)*b+s_deck)*4/6)^3+p_b*((-
sin(theta)*b+s_deck)*4/6)^2))^2+(-(-sin(theta)*b+s_deck)*4/6+
s_deck)^2)

a+L+
g2

(b-(1-cos(alpha))*g2/sin(alpha))

a+L+
g2+
0.1[m
]

(b-(1-cos(alpha))*g2/sin(alpha))-0.1[m]*tan(alpha)
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3 From the Specify list, choose Coordinates.

4 In the xw text field, type a+L.

5 Locate the Endpoint section. From the Specify list, choose Coordinates.

6 In the xw text field, type a+L.

7 In the yw text field, type c_deck+s_deck.

8 Click  Build Selected.

Work Plane 8 (wp8)>Line Segment 2 (ls2)
1 In the Work Plane toolbar, click  More Primitives and choose Line Segment.

2 In the Settings window for Line Segment, locate the Starting Point section.

3 From the Specify list, choose Coordinates.

4 In the xw text field, type a+L+g2.

5 Locate the Endpoint section. From the Specify list, choose Coordinates.

6 In the xw text field, type a+L+g2.

7 In the yw text field, type c_deck+s_deck.

8 Click  Build Selected.

Work Plane 8 (wp8)>Union 1 (uni1)
1 In the Work Plane toolbar, click  Booleans and Partitions and choose Union.

2 Select the object  only.

3 Click the  Select All button in the Graphics toolbar.

4 In the Settings window for Union, click  Build Selected.

Work Plane 8 (wp8)>Delete Entities 1 (del1)
1 Right-click Plane Geometry and choose Delete Entities.

2 On the object uni1, select Boundaries 1–6, 8, 9, and 11 only.

3 In the Settings window for Delete Entities, click  Build Selected.

Work Plane 8 (wp8)
1 In the Model Builder window, click Work Plane 8 (wp8).

2 In the Settings window for Work Plane, click  Build Selected.

Work Plane 9 (wp9)
1 In the Geometry toolbar, click  Work Plane.

2 In the Settings window for Work Plane, locate the Plane Definition section.

3 From the Plane type list, choose Coordinates.
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4 In row Point 3, set x to 7.

5 In row Point 3, set y to c_deck-(p_a*((-sin(theta)*b+s_deck)*5/6)^3+p_b*((-
sin(theta)*b+s_deck)*5/6)^2).

6 In row Point 3, set z to -(-sin(theta)*b+s_deck)*5/6+s_deck.

7 Click  Build Selected.

Work Plane 9 (wp9)>Plane Geometry
In the Model Builder window, click Plane Geometry.

Work Plane 9 (wp9)>Ellipse 1 (e1)
1 In the Work Plane toolbar, click  Ellipse.

2 In the Settings window for Ellipse, locate the Object Type section.

3 From the Type list, choose Curve.

4 Locate the Size and Shape section. In the a-semiaxis text field, type a.

5 In the b-semiaxis text field, type sqrt((c_deck-(p_a*((-sin(theta)*b+s_deck)*
5/6)^3+p_b*((-sin(theta)*b+s_deck)*5/6)^2))^2+(-(-sin(theta)*b+

s_deck)*5/6+s_deck)^2).

6 In the Sector angle text field, type 180.

7 Locate the Position section. In the xw text field, type a.

8 Click  Build Selected.

Work Plane 9 (wp9)>Interpolation Curve 1 (ic1)
1 In the Work Plane toolbar, click  More Primitives and choose Interpolation Curve.

2 In the Settings window for Interpolation Curve, locate the Interpolation Points section.

3 In the table, enter the following settings:

xw (m) yw (m)

a+L-
0.1[m
]

sqrt((c_deck-(p_a*((-sin(theta)*b+s_deck)*5/6)^3+p_b*((-
sin(theta)*b+s_deck)*5/6)^2))^2+(-(-sin(theta)*b+s_deck)*5/6+
s_deck)^2)

a+L sqrt((c_deck-(p_a*((-sin(theta)*b+s_deck)*5/6)^3+p_b*((-
sin(theta)*b+s_deck)*5/6)^2))^2+(-(-sin(theta)*b+s_deck)*5/6+
s_deck)^2)

a+L+
g2

(b-(1-cos(alpha))*g2/sin(alpha))

a+L+
g2+
0.1[m
]

(b-(1-cos(alpha))*g2/sin(alpha))-0.1[m]*tan(alpha)
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4 Click  Build Selected.

Work Plane 9 (wp9)>Line Segment 1 (ls1)
1 In the Work Plane toolbar, click  More Primitives and choose Line Segment.

2 In the Settings window for Line Segment, locate the Starting Point section.

3 From the Specify list, choose Coordinates.

4 In the xw text field, type a+L.

5 Locate the Endpoint section. From the Specify list, choose Coordinates.

6 In the xw text field, type a+L.

7 In the yw text field, type c_deck+s_deck.

8 Click  Build Selected.

Work Plane 9 (wp9)>Line Segment 2 (ls2)
1 In the Work Plane toolbar, click  More Primitives and choose Line Segment.

2 In the Settings window for Line Segment, locate the Starting Point section.

3 From the Specify list, choose Coordinates.

4 In the xw text field, type a+L+g2.

5 Locate the Endpoint section. From the Specify list, choose Coordinates.

6 In the xw text field, type a+L+g2.

7 In the yw text field, type c_deck+s_deck.

8 Click  Build Selected.

Work Plane 9 (wp9)>Union 1 (uni1)
1 In the Work Plane toolbar, click  Booleans and Partitions and choose Union.

2 Select the object  only.

3 Click the  Select All button in the Graphics toolbar.

4 In the Settings window for Union, click  Build Selected.

Work Plane 9 (wp9)>Delete Entities 1 (del1)
1 Right-click Plane Geometry and choose Delete Entities.

2 On the object uni1, select Boundaries 1–6, 8, 9, and 11 only.

3 In the Settings window for Delete Entities, click  Build Selected.

Work Plane 9 (wp9)
1 In the Model Builder window, click Work Plane 9 (wp9).

2 In the Settings window for Work Plane, click  Build Selected.
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Work Plane 10 (wp10)
In the Geometry toolbar, click  Work Plane.

Work Plane 10 (wp10)>Plane Geometry
In the Model Builder window, click Plane Geometry.

Work Plane 10 (wp10)>Ellipse 1 (e1)
1 In the Work Plane toolbar, click  Ellipse.

2 In the Settings window for Ellipse, locate the Object Type section.

3 From the Type list, choose Curve.

4 Locate the Size and Shape section. In the a-semiaxis text field, type a.

5 In the b-semiaxis text field, type c_deck.

6 In the Sector angle text field, type 180.

7 Locate the Position section. In the xw text field, type a.

8 Click  Build Selected.

Work Plane 10 (wp10)>Interpolation Curve 1 (ic1)
1 In the Work Plane toolbar, click  More Primitives and choose Interpolation Curve.

2 In the Settings window for Interpolation Curve, locate the Interpolation Points section.

3 In the table, enter the following settings:

4 Click  Build Selected.

Work Plane 10 (wp10)>Line Segment 1 (ls1)
1 In the Work Plane toolbar, click  More Primitives and choose Line Segment.

2 In the Settings window for Line Segment, locate the Starting Point section.

3 From the Specify list, choose Coordinates.

4 In the xw text field, type a+L.

5 Locate the Endpoint section. From the Specify list, choose Coordinates.

6 In the xw text field, type a+L.

7 In the yw text field, type c_deck+s_deck.

xw (m) yw (m)

a+L-0.1[m] c_deck

a+L c_deck

a+L+g2 (b-(1-cos(alpha))*g2/sin(alpha))

a+L+g2+0.1[m] (b-(1-cos(alpha))*g2/sin(alpha))-0.1[m]*tan(alpha)
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8 Click  Build Selected.

Work Plane 10 (wp10)>Line Segment 2 (ls2)
1 In the Work Plane toolbar, click  More Primitives and choose Line Segment.

2 In the Settings window for Line Segment, locate the Starting Point section.

3 From the Specify list, choose Coordinates.

4 In the xw text field, type a+L+g2.

5 Locate the Endpoint section. From the Specify list, choose Coordinates.

6 In the xw text field, type a+L+g2.

7 In the yw text field, type c_deck+s_deck.

8 Click  Build Selected.

Work Plane 10 (wp10)>Union 1 (uni1)
1 In the Work Plane toolbar, click  Booleans and Partitions and choose Union.

2 Select the object  only.

3 Click the  Select All button in the Graphics toolbar.

4 In the Settings window for Union, click  Build Selected.

Work Plane 10 (wp10)>Delete Entities 1 (del1)
1 Right-click Plane Geometry and choose Delete Entities.

2 On the object uni1, select Boundaries 1–6, 8, 9, and 11 only.

3 In the Settings window for Delete Entities, click  Build Selected.

Work Plane 10 (wp10)
1 In the Model Builder window, click Work Plane 10 (wp10).

2 In the Settings window for Work Plane, click  Build Selected.

Union 1 (uni1)
1 In the Geometry toolbar, click  Booleans and Partitions and choose Union.

2 Click the  Select All button in the Graphics toolbar.

3 In the Settings window for Union, click  Build Selected.

Cap Faces 1 (cap1)
1 In the Geometry toolbar, click  Defeaturing and Repair and choose Cap Faces.

2 On the object uni1, select Edges 46–48 and 60 only.

3 In the Settings window for Cap Faces, click  Build Selected.
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Cap Faces 2 (cap2)
1 In the Geometry toolbar, click  Defeaturing and Repair and choose Cap Faces.

2 On the object cap1, select Edges 44, 45, 48, and 59 only.

3 In the Settings window for Cap Faces, click  Build Selected.

Cap Faces 3 (cap3)
1 In the Geometry toolbar, click  Defeaturing and Repair and choose Cap Faces.

2 On the object cap2, select Edges 42, 43, 45, and 58 only.

3 In the Settings window for Cap Faces, click  Build Selected.

Cap Faces 4 (cap4)
1 In the Geometry toolbar, click  Defeaturing and Repair and choose Cap Faces.

2 On the object cap3, select Edges 40, 41, 43, and 57 only.

3 In the Settings window for Cap Faces, click  Build Selected.

Cap Faces 5 (cap5)
1 In the Geometry toolbar, click  Defeaturing and Repair and choose Cap Faces.

2 On the object cap4, select Edges 38, 39, 41, and 56 only.

3 In the Settings window for Cap Faces, click  Build Selected.

Cap Faces 6 (cap6)
1 In the Geometry toolbar, click  Defeaturing and Repair and choose Cap Faces.

2 On the object cap5, select Edges 36, 37, 39, and 55 only.

3 In the Settings window for Cap Faces, click  Build Selected.

Cap Faces 7 (cap7)
1 In the Geometry toolbar, click  Defeaturing and Repair and choose Cap Faces.

2 On the object cap6, select Edges 34, 35, 37, and 53 only.

3 In the Settings window for Cap Faces, click  Build Selected.

Cap Faces 8 (cap8)
1 In the Geometry toolbar, click  Defeaturing and Repair and choose Cap Faces.

2 In the Settings window for Cap Faces, locate the Cap Faces section.

3 Click  Clear Selection.

4 On the object cap7, select Edges 9, 10, and 27 only.

5 Click  Build Selected.
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Cap Faces 9 (cap9)
1 In the Geometry toolbar, click  Defeaturing and Repair and choose Cap Faces.

2 On the object cap8, select Edges 8, 10, and 25 only.

3 In the Settings window for Cap Faces, click  Build Selected.

Cap Faces 10 (cap10)
1 In the Geometry toolbar, click  Defeaturing and Repair and choose Cap Faces.

2 On the object cap9, select Edges 7, 8, and 23 only.

3 In the Settings window for Cap Faces, click  Build Selected.

Cap Faces 11 (cap11)
1 In the Geometry toolbar, click  Defeaturing and Repair and choose Cap Faces.

2 On the object cap10, select Edges 6, 7, and 21 only.

3 In the Settings window for Cap Faces, click  Build Selected.

Cap Faces 12 (cap12)
1 In the Geometry toolbar, click  Defeaturing and Repair and choose Cap Faces.

2 On the object cap11, select Edges 5, 6, and 19 only.

3 In the Settings window for Cap Faces, click  Build Selected.

Cap Faces 13 (cap13)
1 In the Geometry toolbar, click  Defeaturing and Repair and choose Cap Faces.

2 On the object cap12, select Edges 4, 5, and 17 only.

3 In the Settings window for Cap Faces, click  Build Selected.

Cap Faces 14 (cap14)
1 In the Geometry toolbar, click  Defeaturing and Repair and choose Cap Faces.

2 On the object cap13, select Edges 3, 4, and 15 only.

3 In the Settings window for Cap Faces, click  Build Selected.

Work Plane 11 (wp11)
1 In the Geometry toolbar, click  Work Plane.

2 In the Settings window for Work Plane, locate the Plane Definition section.

3 From the Plane list, choose zx-plane.

4 In the y-coordinate text field, type c_deck.

5 Click to expand the Local Coordinate System section. In the Rotation text field, type 90.

6 Click  Build Selected.
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Work Plane 11 (wp11)>Plane Geometry
In the Model Builder window, click Plane Geometry.

Work Plane 11 (wp11)>Parametric Curve 1 (pc1)
1 In the Work Plane toolbar, click  More Primitives and choose Parametric Curve.

2 In the Settings window for Parametric Curve, locate the Expressions section.

3 In the xw text field, type s_x1+s_l1*s.

4 In the yw text field, type -(5*2*s_deck/s_l1*(a0*s^0.5-a1*s-a2*s^2+a3*s^3-
a4*s^4))*s_l1.

5 Click  Build Selected.

Work Plane 11 (wp11)
1 In the Model Builder window, click Work Plane 11 (wp11).

2 In the Settings window for Work Plane, click  Build Selected.

Work Plane 12 (wp12)
1 In the Geometry toolbar, click  Work Plane.

2 In the Settings window for Work Plane, locate the Plane Definition section.

3 From the Plane list, choose zx-plane.

4 In the y-coordinate text field, type c_deck+s_h.

5 Locate the Local Coordinate System section. In the Rotation text field, type 90.

6 Click  Build Selected.

Work Plane 12 (wp12)>Plane Geometry
In the Model Builder window, click Plane Geometry.

Work Plane 12 (wp12)>Parametric Curve 1 (pc1)
1 In the Work Plane toolbar, click  More Primitives and choose Parametric Curve.

2 In the Settings window for Parametric Curve, locate the Expressions section.

3 In the xw text field, type s_x2+s_l2*s.

4 In the yw text field, type -(5*s_w2/s_l1*(a0*s^0.5-a1*s-a2*s^2+a3*s^3-a4*
s^4))*s_l2.

5 Click  Build Selected.

Work Plane 12 (wp12)>Line Segment 1 (ls1)
1 In the Work Plane toolbar, click  More Primitives and choose Line Segment.

2 In the Settings window for Line Segment, locate the Starting Point section.
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3 Find the Start vertex subsection. Select the  Activate Selection toggle button.

4 On the object pc1, select Point 1 only.

5 Locate the Endpoint section. Find the End vertex subsection. Select the 
 Activate Selection toggle button.

6 On the object pc1, select Point 2 only.

7 Click  Build Selected.

Work Plane 12 (wp12)>Rectangle 1 (r1)
1 In the Work Plane toolbar, click  Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type s_l2.

4 In the Height text field, type s_w2.

5 Locate the Position section. In the xw text field, type s_x2.

6 In the yw text field, type -s_w2.

7 Click  Build Selected.

Work Plane 12 (wp12)>Union 1 (uni1)
1 In the Work Plane toolbar, click  Booleans and Partitions and choose Union.

2 Select the object  only.

3 Click the  Select All button in the Graphics toolbar.

4 In the Settings window for Union, click  Build Selected.

Work Plane 12 (wp12)>Delete Entities 1 (del1)
1 Right-click Plane Geometry and choose Delete Entities.

2 In the Settings window for Delete Entities, locate the Entities or Objects to Delete section.

3 From the Geometric entity level list, choose Domain.

4 On the object uni1, select Domain 1 only.

5 Click  Build Selected.

Work Plane 12 (wp12)
1 In the Model Builder window, click Work Plane 12 (wp12).

2 In the Settings window for Work Plane, click  Build Selected.

Loft 1 (loft1)
1 In the Geometry toolbar, click  Loft.

2 In the Settings window for Loft, locate the General section.
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3 Clear the Unite with input objects check box.

4 Click to expand the Start Profile section. From the Geometric entity level list, choose 
Edge.

5 On the object wp12, select Edge 2 only.

6 Click to expand the End Profile section. From the Geometric entity level list, choose Edge.

7 On the object wp11, select Edge 1 only.

8 Click  Build Selected.

Work Plane 13 (wp13)
1 In the Geometry toolbar, click  Work Plane.

2 In the Settings window for Work Plane, locate the Plane Definition section.

3 From the Plane list, choose yz-plane.

4 In the x-coordinate text field, type a+L+g2+g3.

Work Plane 13 (wp13)>Plane Geometry
In the Model Builder window, click Plane Geometry.

Work Plane 13 (wp13)>Circle 1 (c1)
1 In the Work Plane toolbar, click  Circle.

2 In the Settings window for Circle, locate the Size and Shape section.

3 In the Radius text field, type (b-(1-cos(alpha))*g2/sin(alpha))-g3*tan(alpha).

4 In the Sector angle text field, type 180.

5 Click  Build Selected.

Work Plane 13 (wp13)
1 In the Model Builder window, click Work Plane 13 (wp13).

2 In the Settings window for Work Plane, click  Build Selected.

Work Plane 14 (wp14)
In the Geometry toolbar, click  Work Plane.

Work Plane 14 (wp14)>Plane Geometry
In the Model Builder window, click Plane Geometry.

Work Plane 14 (wp14)>Parametric Curve 1 (pc1)
1 In the Work Plane toolbar, click  More Primitives and choose Parametric Curve.

2 In the Settings window for Parametric Curve, locate the Expressions section.

3 In the xw text field, type r_x1+r_l1*s.
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4 In the yw text field, type -(5*r_w1/r_l1*(a0*s^0.5-a1*s-a2*s^2+a3*s^3-a4*
s^4))*r_l1.

5 Click  Build Selected.

Work Plane 14 (wp14)>Parametric Curve 2 (pc2)
1 In the Work Plane toolbar, click  More Primitives and choose Parametric Curve.

2 In the Settings window for Parametric Curve, locate the Expressions section.

3 In the xw text field, type r_x1+r_l1*s.

4 In the yw text field, type +(5*r_w1/r_l1*(a0*s^0.5-a1*s-a2*s^2+a3*s^3-a4*
s^4))*r_l1.

5 Click  Build Selected.

Work Plane 14 (wp14)
1 In the Model Builder window, click Work Plane 14 (wp14).

2 In the Settings window for Work Plane, click  Build Selected.

Work Plane 15 (wp15)
1 In the Geometry toolbar, click  Work Plane.

2 In the Settings window for Work Plane, locate the Plane Definition section.

3 In the z-coordinate text field, type r_h.

4 Click  Build Selected.

Work Plane 15 (wp15)>Plane Geometry
In the Model Builder window, click Plane Geometry.

Work Plane 15 (wp15)>Parametric Curve 1 (pc1)
1 In the Work Plane toolbar, click  More Primitives and choose Parametric Curve.

2 In the Settings window for Parametric Curve, locate the Expressions section.

3 In the xw text field, type r_x2+r_l2*s.

4 In the yw text field, type -(5*r_w2/r_l2*(a0*s^0.5-a1*s-a2*s^2+a3*s^3-a4*
s^4))*r_l2.

5 Click  Build Selected.

Work Plane 15 (wp15)>Parametric Curve 2 (pc2)
1 In the Work Plane toolbar, click  More Primitives and choose Parametric Curve.

2 In the Settings window for Parametric Curve, locate the Expressions section.

3 In the xw text field, type r_x2+r_l2*s.
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4 In the yw text field, type +(5*r_w2/r_l2*(a0*s^0.5-a1*s-a2*s^2+a3*s^3-a4*
s^4))*r_l2.

5 Click  Build Selected.

Work Plane 15 (wp15)>Rectangle 1 (r1)
1 In the Work Plane toolbar, click  Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type r_l2.

4 In the Height text field, type 2*r_w2.

5 Locate the Position section. In the xw text field, type r_x2.

6 In the yw text field, type -r_w2.

7 Click  Build Selected.

Work Plane 15 (wp15)>Union 1 (uni1)
1 In the Work Plane toolbar, click  Booleans and Partitions and choose Union.

2 Select the object  only.

3 Click the  Select All button in the Graphics toolbar.

4 In the Settings window for Union, click  Build Selected.

Work Plane 15 (wp15)>Delete Entities 1 (del1)
1 Right-click Plane Geometry and choose Delete Entities.

2 In the Settings window for Delete Entities, locate the Entities or Objects to Delete section.

3 From the Geometric entity level list, choose Domain.

4 On the object uni1, select Domains 1 and 2 only.

5 Click  Build Selected.

Work Plane 15 (wp15)
1 In the Model Builder window, click Work Plane 15 (wp15).

2 In the Settings window for Work Plane, click  Build Selected.

Loft 2 (loft2)
1 In the Geometry toolbar, click  Loft.

2 In the Settings window for Loft, locate the General section.

3 Clear the Unite with input objects check box.

4 Locate the Start Profile section. From the Geometric entity level list, choose Edge.

5 On the object wp15, select Edge 2 only.
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6 Locate the End Profile section. From the Geometric entity level list, choose Edge.

7 On the object wp14, select Edge 2 only.

8 Click  Build Selected.

Loft 3 (loft3)
1 In the Geometry toolbar, click  Loft.

2 In the Settings window for Loft, locate the General section.

3 Clear the Unite with input objects check box.

4 Locate the Start Profile section. From the Geometric entity level list, choose Edge.

5 On the object wp15, select Edge 1 only.

6 Locate the End Profile section. From the Geometric entity level list, choose Edge.

7 On the object wp14, select Edge 1 only.

8 Click  Build Selected.

Rotate 1 (rot1)
1 In the Geometry toolbar, click  Transforms and choose Rotate.

2 Select the objects loft2, loft3, and wp15 only.

3 In the Settings window for Rotate, locate the Rotation section.

4 From the Axis type list, choose x-axis.

5 Click  Range.

6 In the Range dialog box, choose Number of values from the Entry method list.

7 In the Start text field, type 0.

8 In the Stop text field, type 270.

9 In the Number of values text field, type 4.

10 Click Replace.

11 In the Settings window for Rotate, click  Build Selected.

Union 2 (uni2)
1 In the Geometry toolbar, click  Booleans and Partitions and choose Union.

2 Select the objects rot1(1), rot1(10), rot1(11), rot1(12), rot1(2), rot1(3), rot1(4), rot1(5), 
rot1(6), rot1(7), rot1(8), and rot1(9) only.

3 In the Settings window for Union, click  Build Selected.

Convert to Solid 1 (csol1)
1 In the Geometry toolbar, click  Conversions and choose Convert to Solid.
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2 Select the object uni2 only.

3 In the Settings window for Convert to Solid, click  Build Selected.

Work Plane 16 (wp16)
1 In the Geometry toolbar, click  Work Plane.

2 In the Settings window for Work Plane, locate the Plane Definition section.

3 In the z-coordinate text field, type b_h1.

4 Click  Build Selected.

Work Plane 16 (wp16)>Plane Geometry
In the Model Builder window, click Plane Geometry.

Work Plane 16 (wp16)>Parametric Curve 1 (pc1)
1 In the Work Plane toolbar, click  More Primitives and choose Parametric Curve.

2 In the Settings window for Parametric Curve, locate the Expressions section.

3 In the xw text field, type b_x1+b_l1*s.

4 In the yw text field, type -(5*b_w1/b_l1*(a0*s^0.5-a1*s-a2*s^2+a3*s^3-a4*
s^4))*b_l1+b_d.

5 Click  Build Selected.

Work Plane 16 (wp16)>Parametric Curve 2 (pc2)
1 In the Work Plane toolbar, click  More Primitives and choose Parametric Curve.

2 In the Settings window for Parametric Curve, locate the Expressions section.

3 In the xw text field, type b_x1+b_l1*s.

4 In the yw text field, type +(5*b_w1/b_l1*(a0*s^0.5-a1*s-a2*s^2+a3*s^3-a4*
s^4))*b_l1+b_d.

5 Click  Build Selected.

Work Plane 16 (wp16)
1 In the Model Builder window, click Work Plane 16 (wp16).

2 In the Settings window for Work Plane, click  Build Selected.

Work Plane 17 (wp17)
1 In the Geometry toolbar, click  Work Plane.

2 In the Settings window for Work Plane, locate the Plane Definition section.

3 In the z-coordinate text field, type b_h2.

4 Click  Build Selected.
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Work Plane 17 (wp17)>Plane Geometry
In the Model Builder window, click Plane Geometry.

Work Plane 17 (wp17)>Parametric Curve 1 (pc1)
1 In the Work Plane toolbar, click  More Primitives and choose Parametric Curve.

2 In the Settings window for Parametric Curve, locate the Expressions section.

3 In the xw text field, type b_x2+b_l2*s.

4 In the yw text field, type -(5*b_w2/b_l2*(a0*s^0.5-a1*s-a2*s^2+a3*s^3-a4*
s^4))*b_l2+b_d.

5 Click  Build Selected.

Work Plane 17 (wp17)>Parametric Curve 2 (pc2)
1 In the Work Plane toolbar, click  More Primitives and choose Parametric Curve.

2 In the Settings window for Parametric Curve, locate the Expressions section.

3 In the xw text field, type b_x2+b_l2*s.

4 In the yw text field, type +(5*b_w2/b_l2*(a0*s^0.5-a1*s-a2*s^2+a3*s^3-a4*
s^4))*b_l2+b_d.

5 Click  Build Selected.

Work Plane 17 (wp17)>Rectangle 1 (r1)
1 In the Work Plane toolbar, click  Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type b_l2.

4 In the Height text field, type 2*b_w2.

5 Locate the Position section. In the xw text field, type b_x2.

6 In the yw text field, type -b_w2+b_d.

7 Click  Build Selected.

Work Plane 17 (wp17)>Union 1 (uni1)
1 In the Work Plane toolbar, click  Booleans and Partitions and choose Union.

2 Select the object  only.

3 Click the  Select All button in the Graphics toolbar.

4 In the Settings window for Union, click  Build Selected.

Work Plane 17 (wp17)>Delete Entities 1 (del1)
1 Right-click Plane Geometry and choose Delete Entities.
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2 In the Settings window for Delete Entities, locate the Entities or Objects to Delete section.

3 From the Geometric entity level list, choose Domain.

4 On the object uni1, select Domains 1 and 2 only.

5 Click  Build Selected.

Work Plane 17 (wp17)
1 In the Model Builder window, click Work Plane 17 (wp17).

2 In the Settings window for Work Plane, click  Build Selected.

Loft 4 (loft4)
1 In the Geometry toolbar, click  Loft.

2 In the Settings window for Loft, locate the General section.

3 Clear the Unite with input objects check box.

4 Locate the Start Profile section. From the Geometric entity level list, choose Edge.

5 On the object wp17, select Edge 2 only.

6 Locate the End Profile section. From the Geometric entity level list, choose Edge.

7 On the object wp16, select Edge 2 only.

8 Click  Build Selected.

Loft 5 (loft5)
1 In the Geometry toolbar, click  Loft.

2 In the Settings window for Loft, locate the General section.

3 Clear the Unite with input objects check box.

4 Locate the Start Profile section. From the Geometric entity level list, choose Edge.

5 On the object wp17, select Edge 1 only.

6 Locate the End Profile section. From the Geometric entity level list, choose Edge.

7 On the object wp16, select Edge 1 only.

8 Click  Build Selected.

Union 3 (uni3)
1 In the Geometry toolbar, click  Booleans and Partitions and choose Union.

2 Select the objects cap14, loft1, loft4, loft5, wp12, wp16, and wp17 only.

3 In the Settings window for Union, click  Build Selected.

Delete Entities 1 (del1)
1 In the Model Builder window, right-click Geometry 1 and choose Delete Entities.
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2 On the object uni3, select Boundaries 19, 20, 22, 24, 26, and 29 only.

3 In the Settings window for Delete Entities, click  Build Selected.

Mirror 1 (mir1)
1 In the Geometry toolbar, click  Transforms and choose Mirror.

2 Select the objects del1 and wp13 only.

3 In the Settings window for Mirror, locate the Input section.

4 Select the Keep input objects check box.

5 Click  Build Selected.

Union 4 (uni4)
1 In the Geometry toolbar, click  Booleans and Partitions and choose Union.

2 Select the objects del1, mir1(1), mir1(2), and wp13 only.

3 In the Settings window for Union, click  Build Selected.

Convert to Solid 2 (csol2)
1 In the Geometry toolbar, click  Conversions and choose Convert to Solid.

2 Select the object uni4 only.

3 In the Settings window for Convert to Solid, click  Build Selected.

Union 5 (uni5)
1 In the Geometry toolbar, click  Booleans and Partitions and choose Union.

2 Select the objects csol1 and csol2 only.

3 In the Settings window for Union, locate the Union section.

4 Clear the Keep interior boundaries check box.

5 Click  Build Selected.

Rotate the submarine to facilitate the visualization.

Rotate 2 (rot2)
1 In the Geometry toolbar, click  Transforms and choose Rotate.

2 Select the object uni5 only.

3 In the Settings window for Rotate, locate the Rotation section.

4 From the Axis type list, choose x-axis.

5 In the Angle text field, type 90.

6 Click  Build Selected.
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The geometry is now finished, the following steps are only needed to improve the quality 
of the mesh.

Work Plane 18 (wp18)
1 In the Geometry toolbar, click  Work Plane.

2 In the Settings window for Work Plane, locate the Plane Definition section.

3 From the Plane list, choose yz-plane.

4 In the x-coordinate text field, type b_x1-0.1[m].

5 Click  Build Selected.

Partition Faces 1 (parf1)
1 In the Geometry toolbar, click  Booleans and Partitions and choose Partition Faces.

2 On the object rot2, select Boundaries 31–34 only.

3 In the Settings window for Partition Faces, locate the Partition Faces section.

4 From the Partition with list, choose Work plane.

5 Click  Build Selected.

Work Plane 19 (wp19)
1 In the Model Builder window, under Component 1 (comp1)>Geometry 1 right-click 

Work Plane 18 (wp18) and choose Duplicate.

2 In the Settings window for Work Plane, locate the Plane Definition section.

3 In the x-coordinate text field, type b_x1+b_l1+0.1[m].

4 Click  Build Selected.

Partition Faces 2 (parf2)
1 In the Geometry toolbar, click  Booleans and Partitions and choose Partition Faces.

2 On the object parf1, select Boundaries 37, 40, 47, and 48 only.

3 In the Settings window for Partition Faces, locate the Partition Faces section.

4 From the Partition with list, choose Work plane.

5 Click  Build Selected.

Work Plane 20 (wp20)
1 In the Model Builder window, under Component 1 (comp1)>Geometry 1 right-click 

Work Plane 19 (wp19) and choose Duplicate.

2 In the Settings window for Work Plane, locate the Plane Definition section.

3 In the x-coordinate text field, type s_x1-0.1[m].
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4 Click  Build Selected.

Partition Faces 3 (parf3)
1 In the Geometry toolbar, click  Booleans and Partitions and choose Partition Faces.

2 On the object parf2, select Boundaries 27 and 29 only.

3 In the Settings window for Partition Faces, locate the Partition Faces section.

4 From the Partition with list, choose Work plane.

5 Click  Build Selected.

Work Plane 21 (wp21)
1 In the Model Builder window, under Component 1 (comp1)>Geometry 1 right-click 

Work Plane 20 (wp20) and choose Duplicate.

2 In the Settings window for Work Plane, locate the Plane Definition section.

3 In the x-coordinate text field, type s_x1+s_l1+0.1[m].

Partition Faces 4 (parf4)
1 In the Geometry toolbar, click  Booleans and Partitions and choose Partition Faces.

2 On the object parf3, select Boundaries 59 and 60 only.

3 In the Settings window for Partition Faces, locate the Partition Faces section.

4 From the Partition with list, choose Work plane.

5 Click  Build Selected.

Work Plane 22 (wp22)
1 In the Model Builder window, under Component 1 (comp1)>Geometry 1 right-click 

Work Plane 21 (wp21) and choose Duplicate.

2 In the Settings window for Work Plane, locate the Plane Definition section.

3 In the x-coordinate text field, type s_x1+3*s_l1/10-1.25[m].

Partition Faces 5 (parf5)
1 In the Geometry toolbar, click  Booleans and Partitions and choose Partition Faces.

2 On the object parf4, select Boundaries 50, 51, 53, and 54 only.

3 In the Settings window for Partition Faces, locate the Partition Faces section.

4 From the Partition with list, choose Work plane.

5 Click  Build Selected.
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Work Plane 23 (wp23)
1 In the Model Builder window, under Component 1 (comp1)>Geometry 1 right-click 

Work Plane 22 (wp22) and choose Duplicate.

2 In the Settings window for Work Plane, locate the Plane Definition section.

3 In the x-coordinate text field, type s_x1+3*s_l1/10+1.25[m].

Partition Faces 6 (parf6)
1 In the Geometry toolbar, click  Booleans and Partitions and choose Partition Faces.

2 On the object parf5, select Boundaries 59 and 62–64 only.

3 In the Settings window for Partition Faces, locate the Partition Faces section.

4 From the Partition with list, choose Work plane.

5 Click  Build Selected.

Form Union (fin)
1 In the Model Builder window, click Form Union (fin).

2 In the Settings window for Form Union/Assembly, click  Build Selected.

Add some selections based on coordinates for the virtual operations.

Box Selection 1 (boxsel1)
1 In the Geometry toolbar, click  Selections and choose Box Selection.

2 In the Settings window for Box Selection, locate the Geometric Entity Level section.

3 From the Level list, choose Edge.

4 Locate the Box Limits section. In the x minimum text field, type 11.5.

5 In the x maximum text field, type 12.5.

6 In the y minimum text field, type -2.

7 In the y maximum text field, type 2.

8 In the z minimum text field, type 3.9.

9 In the z maximum text field, type 4.1.

10 Locate the Output Entities section. From the Include entity if list, choose 
All vertices inside box.

Box Selection 2 (boxsel2)
1 Right-click Box Selection 1 (boxsel1) and choose Duplicate.

2 In the Settings window for Box Selection, locate the Box Limits section.

3 In the x minimum text field, type 21.5.
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4 In the x maximum text field, type 22.9.

5 In the y minimum text field, type -1.25.

6 In the y maximum text field, type -1.18.

Box Selection 3 (boxsel3)
1 Right-click Box Selection 2 (boxsel2) and choose Duplicate.

2 In the Settings window for Box Selection, locate the Box Limits section.

3 In the y minimum text field, type 1.18.

4 In the y maximum text field, type 1.25.

Box Selection 4 (boxsel4)
1 Right-click Box Selection 3 (boxsel3) and choose Duplicate.

2 In the Settings window for Box Selection, locate the Box Limits section.

3 In the x minimum text field, type 22.9.

4 In the x maximum text field, type 24.5.

Box Selection 5 (boxsel5)
1 Right-click Box Selection 4 (boxsel4) and choose Duplicate.

2 In the Settings window for Box Selection, locate the Box Limits section.

3 In the y minimum text field, type -1.25.

4 In the y maximum text field, type -1.18.

5 Click  Build Selected.

Union Selection 1 (unisel1)
1 In the Geometry toolbar, click  Selections and choose Union Selection.

2 In the Settings window for Union Selection, locate the Geometric Entity Level section.

3 From the Level list, choose Edge.

4 Locate the Input Entities section. Click  Add.

5 In the Add dialog box, in the Selections to add list, choose Box Selection 2, 
Box Selection 3, Box Selection 4, and Box Selection 5.

6 Click OK.

Ignore Edges 1 (ige1)
1 In the Geometry toolbar, click  Virtual Operations and choose Ignore Edges.

2 In the Settings window for Ignore Edges, locate the Input section.

3 From the Edges to ignore list, choose Union Selection 1.
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4 Click  Build Selected.

Collapse Edges 1 (cle1)
1 In the Geometry toolbar, click  Virtual Operations and choose Collapse Edges.

2 In the Settings window for Collapse Edges, locate the Input section.

3 From the Edges to collapse list, choose Box Selection 1.

4 In the Geometry toolbar, click  Build All.

Ignore Vertices 1 (igv1)
1 In the Geometry toolbar, click  Virtual Operations and choose Ignore Vertices.

2 Click the  Select All button in the Graphics toolbar.

3 In the Settings window for Ignore Vertices, click  Build Selected.

4 In the Geometry toolbar, click  Export.

5 In the Model Builder window, click Geometry 1.

6 In the Export[noun] window for Geometry, locate the Export section.

7 In the Filename text field, type submarine_target_strength.mphbin.

8 Click the Export entire finalized geometry button.

Click Export to produce the mphbin file that is used at the beginning of the tutorial.
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